
If you ever felt the need to retouch, edit 
or manipulate an image in any way, you 
would probably use Adobe Photoshop. 
Unfortunately, this excellent, industry 
standard piece of software does not come 
in cheap so if you did not have access to 
it, you would have been left pretty much 
stranded – unless you knew about Gimp.

Gimp stands for GNU Image Manipulation 
Program. It is an open-source paint 
program that can be used to perform 
complex tasks such as photo retouching 
and image manipulation or simply as 
a paint program. GIMP is growing in 
popularity at a rapid rate as a complete 
graphics package – it is free and a good 
substitue of Photoshop.

Gimp includes the following features

Gimp has many features one would 
find in a professional program. This 
includes alpha channel support which 
lets you create images on a transparent 
background, multiple layers, a wide range 

of painting tools and unlimited undo 
history, very useful to correct as you can 
go back on previous steps as you work. 
One disadvantage I can see is that it does 
not support CMYK (perhaps not for long) 
– and it is the only missing feature that 
stops professional users from using it in an 
industrial setup. Fortunately, this is no big 
deal for us teachers and our students, and 
certainly does not stop Gimp from being a 
very useful program. Another plus for Gimp 
is that extra plugins are available here 
(also for free), meaning that the number of 
features it can have is virtually limitless.

The Gimp Layout

The way Gimp is created, all windows and 
panels that make up the program can 
be moved around independently, as you 
prefer. The best layout for most users is as 
you see in the screenshot below.

1. The Main Toolbox
2. The Tools Options
3. Image window(s)
4. Layers, Channels, Paths, Undo
5. Brushes, Gradients and Patterns
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Read reviews and tutorials on four free to use  
downloadable graphics related software...

Gimp An Adobe Photoshop alternative

Scribus Create professional looking  
publications for your class or school

Google Sketchup An easy to use 3D 
design program

Inkscape Draw vector illustrations

Gimp feature list

•	 Selections – Rectangle, 
Ellipse, Free select, Fuzzy 
select

•	 Painting tools – Brushes, a 
Pencil and an Airbrush

•	 Alpha channel support for 
working with transparency

•	 Layers - New, Duplicate, 
Merge, Flatten, Mask

•	 Channels – RGB and Alpha – 
(no CMYK channels yet!)

•	 Colour – Balance, Hue/
Saturation, Colorize, Bright/
Contrast, Levels, Curves

•	 Filters – Blur, Enhance, 
Distort, Noise, Artistic, 
Decor, Map, Animation

•	 Undo history, limited only 
by memory

•	 Transformation tools – 
Scale, Rotate, Shear, Flip

•	 Vector drawing paths – 
Design, Edit and Move

•	 Editable Text tool, Text 
along path, Path from text

•	 Support for a wide range of 
file formats, including GIF, 
JPEG, PNG, TIFF, MPEG, PDF, 
PCX, BMP and others

•	 Support for plug-ins – new 
file formats and new effect 
filters.



What is Desktop Publishing?

Desktop Publishing (DTP) software is used 
to create publications such as magazines, 
books, newspapers, leaflets, brochures 
and more, which are then printed on a 
home/office printer or mass produced 
at a printing press. The content for a 
publication is usually created in an external 
program, for example stories are written 
in Microsoft Word, photographs are edited 
in Adobe Photoshop and illustrations 
prepared in Adobe Illustrator. DTP software 
is then used to bring everything together 
by importing all the bits and pieces – the 
final output is exported in .PDF file format 
for easy access.

DTP software available comes divided 
for two target audiences. There is the 
professional kind, which usually comes 
with a hefty price tag – these include 
Quark XPress and Adobe inDesign, and 
there are others which cater for the home/
small office user such as Grasshopper 
PageStream, Microsoft Publisher and Serif 
PagePlus. 

While scavenging Google for open source 
software I bumped into Scribus, which 
is probably the only open source/free 
desktop publishing software out there.  
Weighing in at just over 20 megabytes in 
size, it is a very complete piece of software, 
and includes enough advanced features to 
be used for professional work. Installation 
was smooth and straightforward – on a 
side note, in order to use the EPS image 
format and print preview, a freely available, 
third party software called Ghostscript has 
to be installed.

Creating a new document presents the 
user with a number of options, including 
document layout (single page/double 
sided/3 fold or 4 fold), margin guides, 
bleeds, document size and orientation, 
number of pages and more. Alternatively 
one can opt to use one of the preset 
templates such as brochures or newsletters.

Importing

Importing text, pictures and illustrations 
in Scribus is straightforward. It supports a 
number of text formats, including text files 
(.txt), Html as well as OpenOffice (.sxw). 
Unfortunately Microsoft Word (.doc/.docx) 

is not supported, so Word files have to be 
saved in one of the supported formats. 
Alternatively, the user can do a copy/
paste from Word into Scribus directly. This 
works fine, but formatting is automatically 
removed.

Scribus supports a wide range of popular 
vector file formats out there when it comes 
to importing, including Encapsulated 
Postscript (.eps) and Adobe Illustrator (.ai). 
Image formats supported include .pdf, .gif, 
.jpg, .png, .tif, .psd and many others.

Layout and design

Creating the layout in Scribus is done by 
using a number of tools situated in the 
toolbar on the top part of the display. 
These include insert text frame, insert 
image frame, insert table, shapes and 
polygons as well as a number of different 
type of line tools. Any object created can 
be manipulated at a later stage. 

Text Frames can have text flowing 
automatically from one another. This is 
useful when working with a multi-column 
layout. Just create two (or more) Text 
Frames, click on the first one and import 
the text into it. Subsequently, select the 
Link Text Frames icon, and then select the 
second Text Frame – text will automatically 
spill into it.

The layout and design aspect of this 
software is very extensive, it is up to the 
user to decide how ‘deep’, he or she will go 
into learning and using it. Whatever reason 
you have to use Scribus, whether to create 
a poster for your classroom, a leaflet to 
send home to parents, or the annual school 
publication, it will do the job. If you get 
stuck you can access the help files directly 
from the Help menu. 

If you would like to support the creators of 
Scribus you can do so buy purchasing an 
official printed copy of the manual which is 
available from Amazon.com.

2

Scribus 
Desktop Publishing

LearnIT

Software reviews and 
tutorials written by Conrad 
Fenech and Winston Attard 
at the eLearning Centre.

Layout design by  
Conrad Fenech.

Website
 
http://blogit.skola.edu.mt

Printed at Dormax Press.

Publication produced by the 
Curriculum Management 
and eLearning Department 
within the Directorate for 
Quality and Standards in 
Education and the School 
Resources Management 
Department within the 
Directorate for Educational 
Services.



Scribus: Text flow tutorial

1. The first thing to do is to launch Scribus 
and create a new document. For this 
tutorial, an A4 one page document will do.

2. Now click the ‘Insert Text Frame’ icon and 
draw a large text frame.

3. In order to add text into the text frame, 
select the ‘Edit contents of frame’ icon. This 
will allow you to type, copy/paste or import 
text. Fill the text frame with text.

4. Now split the text frame in two columns. 
From the Windows menu, enable the 
‘Properties’ panel, then click the arrow next 
to ‘Columns & Text Distances’ to reveal this 
feature’s options.

5. Using the arrows to the right of ‘Columns’, 
select ‘2’ – this will split the text frame into 
two columns. Following this, keep adding 
to the ‘Gap’ until you are happy with the 
space between the columns, as seen here:

6. In this step, we will import a picture into 
this document. First create an image frame 
in which a picture will be inserted – just 
click the ‘insert image frame’ icon.

7. Draw an image frame and import an 
image into it (File menu -> Import -> Get 
Image). Place the image frame in the 
middle of the text frame as shown below.

8. As you can see in this image, the ‘white 
space’ within the image frame overlaps the 

text. The text frame has to be edited in a 
way that it goes round the external shape 
of the picture.

From the ‘properties’ panel, expand the 
’shape’ option, then select ‘Use Frame 
Shape’ option. Click ‘Edit’ button – here 
you can edit the frame in a way that it goes 
around the image’s contour. This panel 
contains a lot of buttons and options, but 
for this tutorial only a couple are needed.
Add a bunch of nodes on the frame by 
enabling ‘Add Node’ then clicking on the 
frame. Add a few of these, and then move 
them one by one around your picture. You 
can add more nodes as you go if needed – 
extra nodes can be removed by selecting 
‘remove node’ icon and clicking on them.

After selecting the ‘Move Node’ icon you 
can move nodes around to the edge of the 
picture. When done click ‘End Editing’.

9. That’s all – the end result should look 
something like this (please note that the 
light grey line is just a guide, it will not 
show if you do a print out):
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Read more Scribus tutorials at  
http://wiki.scribus.net/index.
php/Scribus_Video_Tutorials

Scribus Capability List

•	 Supports major image formats 
including SVG

•	 Professional type/image 
setting features include 
CMYK colours and colour 
management

•	 Available in more than 24 
languages

•	 Supports PDF export - 
including transparency and 
encryption

•	 It is not possible to save files 
to Quark XPress or Adobe 
inDesign format

•	 Pantone Management System 
(PMS) is not supported due to 
licencing issues

Free Fonts

Need free fonts? You can find 
many decent ones from here, 
many of which are freely 
downloadable:

http://www.1001fonts.com



blog IT
http://blogit.skola.edu.mt

Follow our tech-blog!
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Graphics software come in two flavours, 
bitmap or vector. The most popular 
commercial bitmap software is Adobe’s 
Photoshop with Gimp coming close on 
its heels as an open source alternative. 
For many years, Freehand was the only 
vector drawing program to be an industry 
standard, until Adobe bought Macromedia, 
the company behind it. Eventually Adobe 
killed off Freehand as it already had a 
similar software, Illustrator.

In this review I am looking at a free, 
open source alternative to Illustrator 
called Inkspace. Just like the program it 
gets inspiration from, at first it can look 
complicated (but really it is not that hard 
to learn and use) but end results look 
great. Starting a new document gives the 
user a number of layouts to choose from, 
including A4, DVD cover sleeve, business 
card and many more. Alternatively one 
can manually edit these sizes through the 
document properties menu.

Inkspace’s layout may look quite busy. 
A number of toolbars rest on top of the 
artboard and similar to Illustrator, the tools 
are made available through a toolbar on 
the left side of the display. Through these 
tools one can draw basic shapes such 
as triangle, square and circle and their 

attributes, including the stroke (outline) 
thickness and colour, fill colour and so on 
can be changed as needed. Subsequently, 
forms can be merged, intersected, divided 
and cut using options available in the ‘Path’ 
menu. ‘Draw Bezier Curves/Straight Lines’ 
tool from the toolbar is used to draw a 
shape or a path manually. Once a shape has 
been created, it can be manually edited, 
first by clicking ‘Edit paths by node’ tool, 
and by then manipulating the nodes.
Shapes, paths and also text can be 
manipulated as needed by the user. These 
can be resized, flipped, rotated, duplicated 
or distributed around the artboard as 
required. Objects can also be accurately 
placed within the document using the X 
and Y co-ordinates. Similarly, these can be 
made bigger and smaller using the Width 
and Height attributes.

Inkspace document files are saved as an 
.SVG format. Other industry standard 
vector formats are supported, including 
.EPS and .PDF. Alternatively files can be 
saved as a bitmap in .PNG format.
I recommend Inkscape a lot, do not let 
its busy appearance discourage you, it is 
not difficult to work with and with some 
dedication you will be able to create 
drawings, logos or even handouts to be 
used in your class. You do not have to 
learn about all the tools and options to be 
proficient with Inkscape, in fact, with very 
few tools you can create good illustrations. 
This software can come useful especially 
for subjects in which illustrations are used, 
including Maths (Geometry) and Graphical 
Communication.

Inkscape 
Vector drawing software

The programs listed in this issue 
of LearnIT have been approved 
by MITA with the following 
reference numbers:

Scribus 789327
Sketchup 789323
Inkscape 789326
GIMP 789142

If you would like to install any 
of the above software on the 
desktops... 

If you are in the

Primary:
Contact your school eLearning 
Support Teacher

Secondary:
Contact your school technician 



The difference between the two types 
implies how data is drawn to the screen. An 
image is formed by a number of small dots 
adjacent to each other, known as pixels.

Look at the above image, one can see a 
black line going from A1 through A4. You 
and I, as humans can see the relationship 
with each pixel, but once saved as a 
bitmap image format, a computer does 
not ‘understand’ that these pixels form a 
straight line. 

The file format (such as .JPG, .PNG, .BMP 
and many others) stores the data to build 
the image by giving the individual RGB 
(red, green, blue) values for each pixel.

For example, in the above image’s case, the 
file would include the following data:

A0: Black, A1: White, A2: White, A3: White, A4: 

White, B1 White, B2 Black and so on.

When a bitmap picture, such as a photo 
is enlarged, it looks blurry as it would 
not have the data need to fill in the gaps 
formed by the new extra pixels added.

In vector drawings, on the other hand, 
the computer is ‘aware’ of the shapes and 
forms, and it ‘understands’ the relationship 
between the pixels that form them. This 
means that vector drawings can be scaled 
infinitely without ever loosing quality. For 
example, fonts are a type of vector – they 
can be enlarged as much as one wants and 
sharpness is always retained.

For the same image to the left, a vector file 
(such as .PDF, .EPS, etc.) would include the 
following instruction:

Draw a line between A1 and D4

Subsequently, if the user had to move pixel 
D4 to another position, Adobe Illustrator, 
Inkscape or whatever program is being 
used will redraw the pixels for a line image 
to be retained. This would not be possible if 
the image was a bitmap.

As a rule, all vector images have to be 
created from scratch by a user. Photos or 
scanned images are automatically bitmap, 
and cannot be converted to vector. 

Vector images can be saved in bitmap 
image format but cannot be converted 
back.

Embed: Best use of ICT
 Experience and create with technology including animation,  
 robotics, creating graphics, working with interactive surfaces,  
 Nintendo Wii, Design and Technology and more.

 Open for the public:
 Saturday, 22nd May (09.00-13.00), Sunday, 23rd May (15.00-19.00)

 Venue: Excelsior Hotel Floriana

Vector and Bitmap, the differencesDownload Inkscape from  
http://www.inkscape.org

Get Inkscape Tutorials from:

http://inkscapetutorials.
wordpress.com

Get free to use clipart for 
Inkscape from here:

http://openclipart.org
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Google Sketchup 
3D Drawing Program

3D for everyone! SketchUp is a fun-to-use and easy-to-learn piece of 
software that won an award in 2000 for its low learning curve.  It is a 
fast and versatile 3D modelling application that allows you to quickly 
create objects, furniture and buildings. You can use SketchUp for fun to 
draw three-dimensional virtual models or for practical projects, such as 
planning a kitchen or designing a bookshelf. 

In this tutorial we shall build a simple model of a chair, step by step.

1. Open a New document in 
SketchUp and draw a square of 
0.40m with the Rectangle tool from 
the Toolbox. Start at the intersection 
point and input the exact 
measurements in the Dimensions 
box, bottom right of the drawing 
area. 

2. Use the Orbit tool to view in 
perspective and the Push/Pull 
tool to extrude upwards. Use the 
Dimensions box to input extraction 
of 0.04m.

3. View from the top with the Orbit 
tool and use the Tape Measure tool 
to drag guides (dotted lines) 0.04m 
inside the rectangle to position the 
legs.

4. Draw an arc with the Arc tool at 
the front of the chair and draw two 
diagonal lines with the Line tool 
on the sides to form the seat. Use 
the Push/Pull tool to eliminate the 
excess spaces.

5. Use the Orbit tool to view 
the bottom of the seat. Draw 4 
rectangles of 0.04m square at 
intersection of guides and extrude 
downwards (Push/Pull) to 0.45m. it is 
easier to extrude in perspective view 
using the Orbit tool.

6. Bring the view from the front 
to draw a rectangle forming the 
back of the chair of 0.40m height. 
Use the Dimensions box for exact 
measurements. Extrude to 0.03m 
depth.

7. Enlarge front to view back of seat. 
draw horizontal guidelines 0.060m 
from each other starting from the 
top and 2 verticals, 0.03m from the 
sides. 

8. Using the guides draw 3 
rectangles under each other and 
extract to create the 3 spaces of the 
back.



9. Enlarge with the Zoom tool to view the back legs and drag down a guide line 0.05m 
from the seat. Draw a circle on the inside back leg using the guideline and extrude to the 
inside front leg. Repeat procedure on the other side.

10. From Main Menu, File>Select All and use the Move/Copy tool to move the chair up so 
that the legs are positioned on the horizontal red line.

11. To add shadow, from Main Menu go to Window>Shadows and adjust your preference 
from the Shadow Settings window.

12. Chose the Paint Bucket from the Toolbox and from main Menu move to Window> 
Materials to pick a wood sample and fill the chair.

Save as a 2D drawing, a 3D model or as a SketchUp file (skp).  

Get more Inkscape Tutorials from http://inkscapetutorials.wordpress.com

LearnIT this Summer 
Innovative ICT Courses including....
Free web-based applications for teaching   /   Implementing eLearning in class using podcasting 
Implementing blogs in classroom culture   /   Learning by discovery: Webquests
/    Editing your own videos using Windows Movie Maker   /   Learning with robotic kits in the Primary 
School classroom   /   Using the interactive whiteboard   /   ePortfolios and other eTools for educators  
/    Using Concept Maps to facilitate meaningful learning

For more information visit http://courses.skola.edu.mt 
or phone 2598 2167 during school hours.

Download Inkscape from  
http://sketchup.google.com



Using Gimp

Gimp is a powerful program very similar 
to Photoshop and therefore it may take 
some time for the user to become familiar 
with the layout and tools. Simple tasks are 
straight forward but if you plan to use it 
extensively it is a good idea to take a look 
at Gimp’s official documentation here and 
tutorials here. Alternatively you can look 
up for video tutorials on YouTube.

Continued from front page...

Gimp Panels

Main image window - where the main menu is also displayed. Multiple image windows 
can be open at the same time.

Red Eye Reduction Tutorial

Removing red-eye effect, caused by the 
camera flash, from your photos.

To correct red-eye effect in Gimp we 
resort to the Filters drop-down menu.

1. Open a photograph with red-eye 
effect.

2. Use the Magnifier to enlarge the 
view to focus on one eye.

3. Drag in guidelines from the side 
and top rulers and stop at the pupil. 

4. From the selection options select 
feathering and type 3 as number of 
pixels to feather.

5. From the intersection of the guides 
draw an eliptical selection to cover 
the pupil. Use the shift to select a 
perfect circle around the pupil.

6. From the Main Menu select 
Filters>Enhance>Red-Eye 

Removal...
7. With the Threshold at 50, click OK in 

the ‘Red Eye Removal’ window.
8. Repeat the steps to remove the red-

eye effect from the other eye.

The filter is surprisingly effective and 
the final result is optimum.

The main Toolbox Tool Options
Changes according to tool

Layers, Channels, Paths, 
Undo palette

Brushes, Patterns,
Gradients windows

Read more Gimp tutorials at  
http://www.gimp.org/tutorials


